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BAB III  

PELAKSANAAN KERJA MAGANG 

3.1 Kedudukan dan Koordinasi 

Pelaksanaan kegiatan kerja magang di Laboratorium FSD UMN sebagai 

graphic designer atau illustrator, berperan untuk mengerjakan beberapa asset 

visual kebutuhan konten dari Laboratorium FSD, dan memberikan ide kreatif pada 

proyek internal maupun external dari Laboratorium FSD. Selama proses kerja 

magang berlangsung, penulis bekerja dibawah supervisor.  

Proses kerja magang dilakukaan secara tatap muka atau offline, jika ada hal 

yang tidak memungkinkan dan penulis tidak dapat hadir, maka pekerjaan dilakukan 

dari jarak jauh atau WFH. Pekerjaan dilaksanakan setiap hari senin sampai hari 

jumat, dari pukul 08.00 sampai pukul 17.00 sesuai dengan ketentuan yang telah 

diberikan. Kemudian koordinasi dilakukan secara langsung atau melalui whatsapp 

untuk melaporkan beberapa hal terkait dengan pekerjaan yang telah dilakukan 

kepada supervisor. Penulis mendapatkan brief tugas atau pekerjaan dari supervisor, 

setelah semua pekerjaan sudah dikerjakan penulis memberikan info dan meminta 

untuk asistensi pada supervisor. 

Lalu, supervisor dapat revisi hasil pekerjaan yang telah dikerjakan oleh 

penulis, selanjutnya ketika supervisor sudah setuju dengan hasilnya, penulis dapat 

mengumpulkan langsung hasil pekerjaan di satu folder pengumpulan yang sudah 

disediakan oleh supervisor. 
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Gambar 3. 1 Bagan alur koordinasi 

 

3.2 Tugas yang Dilakukan 

Berikut beberapa tugas dan tanggung jawab yang dikerjakan penulis sebagai 

graphic designer atau illustrator di Laboratorium FSD UMN. 

Tabel 3. 1 Detail pekerjaan yang dilakukan selama magang 

No. Minggu Proyek Keterangan 

1.  1 (12 Februari – 

16 Februari 2024) 

- Digital Painting 

(kelas lab) 

- Instagram Post Hari 

Raya 

- Menyusun ppt materi kelas 

lab. 

- Sketsa konten instagram. 

- Demonstrasi digital painting. 

2. 2 (19 Februari – 

23 Februari 2024) 

- Instagram Post Hari 

Raya 

- Design Asset (ppt) 

- Mengerjakan desain Hari 

Raya. 

- VO untuk video tutorial 

Adobe Illustrator. 

- Membuat asset ppt non 

akademis mengenai basic 

Adobe Illustrator. 
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3. 3 (26 Februari –29 

Februari 2024) 

- Instagram Post Hari 

Raya 

- Design Asset (ppt) 

- Membuat asset ppt non 

akademis mengenai basic 

Adobe Illustrator. 

- Mengerjakan desain Hari 

Raya. 

4. 4 (01 Maret – 08 

Maret 2024) 

- Instagram Post Hari 

Raya 

- Instagram Reels 

(tutorial) 

- Mengerjakan desain Hari 

Raya. 

- Mengerjakan konten video 

tutorial Adobe Ilustrator. 

5. 5 (12 Maret – 15 

Maret 2024) 

- Instagram Post Hari 

Raya 

- Instagram Reels 

(tutorial) 

- Mengerjakan desain Hari 

Raya. 

- Mengerjakan konten video 

tutorial Adobe Ilustrator. 

6. 6 (18 Maret – 22 

Maret 2024) 

- Instagram Post Hari 

Raya 

- Instagram Reels 

(tutorial) 

- Mengerjakan konten video 

tutorial Adobe Ilustrator. 

- Mengerjakan desain Hari 

Raya. 

- Riset desain website. 

7. 7 (25 Maret – 27 

Maret 2024) 

- Instagram Reels 

(tutorial) 

- Riset desain website. 

- Membuat list konten tutorial. 



 

 

17 
Perancangan Asset Visual …, Kezia Rebecca Mamusung, Universitas Multimedia Nusantara 

 

8. 8 (01 April – 05 

April 2024) 

- Instagram Reels 

(tutorial) 

- Ilustrasi (digital 

painting) 

- Riset website. 

- Membuat ilustrasi untuk lab 

ilustrasi. 

- Mencari buku. tentang desain 

website 

- Membuat konten tutorial 

Adobe Illustrator part 2. 

9. 9 (15 April – 19 

April 2024) 

- Instagram Post Hari 

Raya 

- Revisi video tutorial. 

- Mencari ide untuk konten 

tutorial Adobe Photoshop. 

- Membuat desain postingan 

untuk Hari Kartini. 

10. 10 (22 April – 26 

April 2024) 

- Supergrafis website 

Gapura 

- Brief supergrafis 

- Mencari referensi 

- Membuat alternatif asset 

desain untuk website gapura 

11. 11 (29 April – 04 

Mei 2024) 

- Logo Gapura 

 

- Asistensi asset desain website 

- Brief logo Gapura 

- Membuat alternatif logo 

Gapura 
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12. 12 (06 Mei – 11 

Mei 2024) 

- Logo Gapura 

 

- Membuat alternatif logo 

Gapura 

13. 13 (13 Mei – 18 

Mei 2024) 

- Logo Gapura 

 

- Membuat alternatif logo 

Gapura 

- Revisi logo (mengubah 

warna) 

- Meeting 

14. 14 (20 Mei – 24 

Mei 2024) 

- Materi ppt non 

akademis 

 

- Menyusun materi ppt non 

akademis mengenai tracing 

 

3.3 Uraian Pelaksanaan Kerja Magang 

Saat periode magang berlangsung, pembagian kerja sudah diberikan oleh 

Tiara Hanifah, yang merupakan Lab Officer FSD, sebagai supervisor penulis saat 

kerja magang. Pekerjaan yang dikerjakan berupa asset visual untuk konten di akun 

instagram Laboratorium FSD UMN. 

3.3.1 Proses Pelaksanaan 

Pekerjaan dimulai pada tanggal 12 Februari 2024, hari pertama 

penulis menerima brief dari supervisor mengenai pembagian tugas dan terkait 

dengan proyek yang akan dilakukan. Penulis mendapatkan tugas untuk 

membuat asset desain untuk kebutuhan konten Hari Raya, untuk instagram 

post Laboratorium FSD UMN serta membuat konten lainnya yang berkaitan 

dengan Laboratorium FSD UMN. 
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3.3.1.1 Kelas Lab Ilustrasi 

Pada proyek ini penulis diminta untuk menjadi asisten kelas 

untuk mendemonstrsaikan digital painting pada kelas lab. Membuat 

gambar bunga tulip menjadi referensi penulis untuk menggambar, 

karena bentuknya yang simple dan mudah untuk di demontrasikan. 

Sebelumnya penulis diminta untuk latihan menggambar dan 

komunikasi, dan menghitung durasi pembuatan digital painting agar 

sesuai dengan waktu yang sudah ditentukan yaitu 1 jam. Kelas lab 

diadakan pada tanggal 16 Februari 2024 via zoom meeting, pukul 

18.00 sampai 20.00, dengan pengajar Jupiter Natanael.  

 

 

Gambar 3. 2 Referensi gambar untuk digital painting 
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Berikut hasil karya penulis tanpa latar belakang warna saat 

mencoba untuk mempraktikan membuat gambar bunga tulip dari 

referensi yang sudah ada, pada proses ini penulis mendapatkan 

beberapa catatan untuk selanjutnya penulis demonstrasikan pada kelas 

lab. 

 

Gambar 3. 3 Hasil karya latihan tanpa background 

 

Adapula karya latihan penulis yang sudah menggunakan 

latar belakang warna untuk memperkirakan apakah saat praktik pada 

kelas lab cukup waktu untuk menambahkan latar belakang pada 

gambar. Penulis membuat dua alternatif warna yaitu ungu dan merah 

muda. 
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Gambar 3. 4 Hasil karya latihan dengan background 

 

Saat memulai penulis mendemonstrasikan gambar sesuai 

dengan materi kelas, yaitu menggambar menggunakan teknik 

grayscale tanpa mengganti brush atau warna brush dan memanfaatkan 

mode layer. Aplikasi yang digunakan adalah Adobe Photoshop. Pada 

tahap awal penulis membuat ukuran canvas berukuran 2480 x 3508px 

atau sama dengan ukuran A4 (21 x 29,7cm).  Saat memulai penulis 

langsung membuat base color dengan warna abu-abu untuk 

mengetahui bentuk dasar yang akan digambar.  
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Gambar 3. 5 Base color menggambar bunga tulip 

 

Kemudian untuk langkah selanjutnya menambahkan layer 

baru diatas layer base color dan di clipping mask, mode layer diubah 

menjadi multiply untuk memberikan bayangan atau mengatur sisi 

gelap terang pada gambar. Penulis juga memberikan informasi saat 

kelas berlangsung untuk menata layer dan mengubah nama layer agar 

tidak berantakan serta rapih. 
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Gambar 3. 6 Proses clipping mask & multiply 

 

Lalu, menambahkan layer diatas layer multiply dengan mode 

normal untuk menambahkan bagian terang pada gambar. Layer 

selanjutnya layer yang diubah menjadi mode color untuk memberikan 

warna pada gambar. Pada layer ini warna disesuaikan dengan 

referensi. 

 

Gambar 3. 7 Proses memberikan warna 



 

 

24 
Perancangan Asset Visual …, Kezia Rebecca Mamusung, Universitas Multimedia Nusantara 

 

Untuk langkah selanjutnya menambahkan layer baru diatas 

layer color dengan mode normal untuk menambahkan warna kontras, 

bayangan dan bagian ini dapat ditambahkan detail sesuai dengan palet 

warna, agar mendapatkan bentuk yang diinginkan. Tahap terakhir 

layer baru dengan mode soft light untuk menambahkan pencahayaan 

pada gambar.  

 

Gambar 3. 8 Proses detail digital painting 

 

Ada beberapa kendala saat melaksanakan proyek ini, yaitu 

penulis tidak terbiasa menggambar sembari berkomunikasi 

menjelaskan progress dari digital painting, kemudian menyesuaikan 

waktu demonstrasi dengan waktu yang sudah ditentukan. 

Solusi yang penulis lakukan adalah latihan demonstrasi 

sembari berkomunikasi seakan-akan sedang menjelaskan pada 

mahasiswa dan merekam durasi latihan agar penulis dapat mengetahui 

berapa lama progress membuat gambar bunga tulip. 
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Gambar 3. 9 Dokumentasi Kelas Lab 

 

3.3.1.2 Visual Konten Hari Raya 

Sesuai dengan brief yang telah diberikan diawal pertemuan, 

penulis dengan rekan kerja magang mulai menentukan tema desain 

untuk instagram post. Brief serta referensi yang diberikan oleh 

supervisor adalah memiliki palet warna yang berlaku untuk jangka 

waktu yang panjang, to the point, dan minimalis. Lalu, penulis 

berdiskusi dengan rekan kerja untuk menentukan tema desain untuk 

periode ini dan sudah diputuskan desain akan menggunakan tema 
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‘Digital Schedule’ dengan style desain vector minimalis. Kemudian 

penulis mencari referensi beberapa instagram post, referensi ilustrasi 

dan palet warna digunakan yang sekiranya cocok untuk akun 

instagram feeds Lab FSD UMN.  

 

Gambar 3. 10 Referensi warna instagram feeds 

 

Kemudian, terdapat dua pilihan warna dengan tone warna 

yang berbeda. Dua warna dari referensi digunakan karena identik 

dengan warna UMN, lalu untuk warna lainnya seperti orange 

digunakan sebagai warna pendukung yang sekiranya selaras dengan 

warna yang dipilih untuk memberi kesan yang kontras pada desain. 

Sementara itu, warna terakhir adalah warna pastel dari orange cool 

tone sebagai warna pendukung kedua agar desain tidak monoton. 
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Gambar 3. 11 Pilihan palet warna 

 

Setelah, mempertimbangkan referensi yang nantinya akan 

digunakan untuk mendesain, palet warna yang akan digunakan adalah 

warna dengan pilihan pertama karena warna lebih bervariasi dan 

menarik. 

 

 

Gambar 3. 12 Palet warna yang digunakan 

 

Untuk referensi ilustrasi full vector, minimalis seperti style 

desain korea yang tidak terlalu menggunakan banyak warna dan masih 

serasi. Tema ‘Digital Schedule’ dipilih karena sesuai dengan 

Laboratorium FSD yang sepenuhnya harus di schedule atau 

direncanakan terlebih dahulu, lalu berhubungan dengan konten 

instagram post, atau digital platform, kemudian kata ‘digital’ dikira 

cocok untuk tema desain periode saat ini.  
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Gambar 3. 13 Referensi style desain 

 

Hal pertama yang dilakukan sebelum mendesain adalah 

membuat sketsa atau beberapa alternatif, minimal dua atau tiga 

alternatif untuk diasistensikan nantinya. Proses sketsa atau membuat 

alternatif desain, langsung menggunakan aplikasi Adobe Illustrator, 

dengan ukuran 1080x1080px. 

Lalu, untuk membuat desain alternatif penulis menjabarkan 

beberapa ide objek sesuai dengan tema hari raya, agar dapat 

menentukan tata letak dan desain yang sekiranya sepadan dengan 

tema. 

 

Gambar 3. 14 Format standar Hari Peringatan 
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Untuk menentukan objek yang akan diposting di akun resmi 

Laboratorium FSD, penulis juga mencari tahu atau riset mengenai 

tema hari raya yang akan didesain. Layout headline dan logo pada 

instagram post sudah mengikuti template atau format standar untuk 

hari peringatan yang sudah disiapkan oleh supervisor, tetapi tata letak 

tersebut tidak selalu digunakan karena menyesuaikan desain yang 

dibuat, dan penulis hanya perlu menyesuaikan dengan desain yang 

baru. Setelah membuat beberapa alternatif dan sudah disetujui oleh 

supervisor, selanjutnya adalah proses digitalisasi. Kemudian, pada 

tahap ini dapat direvisi atau dimaksimalkan lagi desainnya sesuai 

dengan brief yang supervisor sudah berikan. Pada proses mendesain 

penulis lebih sering menggunakan pathfinder dan pen tool untuk 

membuat bentuk, kemudian font poppins dipilih karena bersifat netral 

dan dapat digunakan disemua postingan. 

Namun, ada beberapa konten yang penulis kerjakan hanya 

perlu menyelesaikan bagian final saja, karena sketsa sudah dikerjakan 

oleh rekan kerja. Lalu, stroke yang digunakan pada desain berukuran 

4pt sampai 6pt tebalnya, agar keseluruhan desain tidak terlihat flat. 

Namun, desain tidak seluruhnya menggunakan asset atau objek 

dengan tema ‘digital schedule’, karena menyesuaikan dengan tema 

hari raya dan kebutuhan postingan saja. Jika tema desain awal 

dianggap tidak sepadan dengan tema hari raya, maka desain hanya 

menyesuaikan dengan tema hari raya.  

Kemudian ada beberapa konten terkait hari raya yang berupa 

animasi. Diharuskan penulis membuat asset visual untuk nantinya 

dijadikan animasi oleh tim editor. Sama seperti membuat desain 

konten instagram post, penulis membuat sketsa untuk tahap 

awalannya agar mengetahui ukuran objek dan tata letak sebelum hasil 

final desain. 
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Penulis juga menjabarkan atau membuat list untuk mencari 

ide asset yang akan digunakan. Pada desain konten ini, penulis ingin 

membuat desain yang berbeda dari konten instagram post lain 

contohnya seperti pada desain hari buruh, yang selalu di desain hanya 

dengan objek perkakas yang identik dengan pekerja proyek bangunan. 

Sementara, hari buruh memiliki arti hari pekerja yang berarti semua 

profesi memperingati perjuangan gerak buruh dalam mencapai hak-

hak kerja yang adil dalam kondisi kerja yang manusiawi 

(kompaspedia.id). Berikut merupakan konten hari peringatan atau hari 

raya yang penulis kerjakan: 

a) Hari Pemilu 

Untuk desain ini penulis mencari beberapa referensi background, 

dan objek utama yang akan ditampilkan seperti kotak suara dan 

kertas-kertas. Kemudian, penulis membuat dua alternatif sketsa dan 

selanjutnya dibuat hasil finalnya. 

 

Gambar 3. 15 Referensi postingan hari pemilu 

 

Untuk sketsa yang dipilih adalah sketsa pertama yaitu yang 

bertema schedule dengan tangan yang sedang memasukan kertas 

suara pada kotak suara. 
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Gambar 3. 16 Sketsa desain hari pemilu 

 

Untuk proses desain finalnya konsep kotak suara dengan kertas 

yang berhamburan disekelilingnya dari sketsa kedua digunakan agar 

white space tidak terlalu kosong. Kemudian pada tanggal yang 

terletak dilatar belakang diberikan lingkaran dan tanda seru serta kata 

‘Ke TPS’ sebagai pengingat utama. 

 

Gambar 3. 17 Hasil akhir desain hari pemilu 
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b) Hari Nyepi 

Pada konten hari nyepi, penulis membuat asset visual yang 

nantinya akan dijadikan motion graphic. Tahap awal penulis 

mengumpulkan ide objek asset desain yang nantinya akan dibuat 

dengan menyusun atau dibuat listnya. Lalu, dipilih yang sekiranya 

sesuai dengan tema hari raya. 

Tabel 3. 2 List ide konten hari nyepi 

HARI NYEPI 

- Karakter 

- Pakaian Bali 

- Pura Bali 

- Bunga Kamboja 

- Daun 

- Sunset (Yellow/Orange) 

 

Setelah membuat daftar ide objek yang nantinya akan 

didesain, penulis mencari referensi gambar agar hasil tepat dan 

mamuaskan. Referensi karakter diambil dari hasil desain konten hari 

raya nyepi yang penulis temukan di internet, kemudian penulis 

mencari foto pura bali untuk dijadikan vector, lalu penulis juga riset 

mengenai pakaian adat bali saat merayakan hari nyepi untuk 

mendesain pakaian pada karakter. Kemudian bunga kamboja yang 

identik dengan bunga dibali dan batik megamendung yang penulis 

ambil objek awannya karena identik dengan batik di Indonesia. 
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Gambar 3. 18 Referensi desain untuk hari nyepi 

 

Berikut hasil sketsa atau final yang sudah dibuat oleh penulis 

yang nantinya akan diberi warna. Asset desain dibuat masing-masing 

tiap objek menggunakan pen tool. Ada beberapa catatan untuk konten 

animasi ini penulis menggunakan karakter agar lebih unik dan agar 

konten berbeda dengan konten hari raya lainnya. Asset desain dari 

konten ini tidak terlalu banyak, tetapi dibuat padat agar tidak terlalu 

kosong. 
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Gambar 3. 19 Sketsa desain untuk hari nyepi 

 

Hasil akhir cenderung dengan warna putih dan tidak full 

color, untuk menonjolkan karakter headline ‘Hari Raya Nyepi’. 

Desain akhir masih dapat diubah layoutnya saat proses animasi. 

Berikut penulis jabarkan dari asset desain yang sudah dibuat, pada 

desain terdapat objek karaktek laki-laki dan perempuan, pura, bunga 

kamboja, dan awan megamendung. Pura dan bunga kamboja dipilih 

karena identik dengan Bali, secara mayoritas penduduk Bali beragama 

Hindu yang merayakan Hari Raya Nyepi. Untuk pemilihan objek 

awan megamendung diambil dari batik megamendung sebagai 

pendukung desain yang menyatakan perayaan tersebut ada di 

Indonesia dan objek langit. 
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Gambar 3. 20 Desain akhir hari nyepi 

 

Setelah hasil desain akhir sudah disetujui, asset visual yang 

akan dianimasikan berbeda dengan desain instagram post, untuk 

animasi asset tidak menggunakan objek dengan ukuran kecil agar 

mudah dianimasikan dan tidak rumit saat di edit. Penulis juga harus 

memisahkan satu persatu asset desain disetiap artboardnya untuk 

nantinya diserahkan pada editor. 

 

Gambar 3. 21 Asset visual untuk hari nyepi 
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c) Hari Paskah 

Tahap awal penulis membuat tiga alternatif desain, desain 

pertama penulis membuat window website sebagai background, 

kelinci yang sedang melihat keatas, dan sticker telur yang identik 

dengan hari paskah. Desain kedua dibuat tiga telur yang dihias 

dengan headline ditengah. Desain ketiga dengan konsep permainan 

mesin capit didalam gadget, terdapat kelinci yang sedang mengintip 

diatas dan balon terbalik. 

 

Gambar 3. 22 Alternatif desain kasar untuk hari paskah 

 

Lalu desain yang dipilih adalah desain yang pertama, tetapi 

mendapat revisi untuk menambahkan objek kelinci yang sedang 

mengintip diatas kiri. Kemudian menambahkan objek awan pada 

sebelah kanan. 
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Gambar 3. 23 Desain final untuk hari paskah 

 

Tetapi pada bagian atas masih terlihat sangat kosong dan terlihat 

ganjal. Maka dari itu penulis diminta untuk menambahkan satu objek 

lagi yang sekiranya sepadan dengan tema. Penulis menambahkan 

objek search bar pada bagian atas dan tulisan Lab FSD UMN pada 

bagian task bar window, lalu menambahkan beberapa hiasan kecil 

pada white space. 

 

Gambar 3. 24 Desain akhir untuk hari paskah 
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d) Hari Raya Idul Fitri 

Tahap pertama membuat daftar ide objek yang nantinya akan 

didesain pada alternatif desain yang sesuai dengan tema hari raya. 

Daftar ide merupakan hasil riset dan mencari referensi desain konten 

yang pernah dibuat pada internet dan referensi hari raya. Riset 

diperlukan agar tidak terjadi kesalahpahaman saat mendesain dan 

tidak ada kekurangan saat membuat desain. 

 

Tabel 3. 3 List ide untuk hari raya idul fitri 

HARI RAYA IDUL FITRI 

- Masjid 

- Bulan 

- Bedug 

- Bintang 

- Ketupat 

- Awan-awan dan lampu 

 

Penulis membuat tiga alternatif desain yang sesuai dengan tema, 

untuk desain pertama dengan konsep arsip dan stiker digital, terdapat 

objek utama yaitu masjid, kemudian objek ketupat dan awan. Untuk 

desain kedua penulis membuat objek utama lampu lentera dengan 

headline didalam lampu dan posisi tetap ditengah, terdapat objek 

awan dan bintang. Pada desain ketiga penulis menggabungkan 

konsep dari desain satu dan dua, tetapi objek masjid dibuat siluet saja. 



 

 

39 
Perancangan Asset Visual …, Kezia Rebecca Mamusung, Universitas Multimedia Nusantara 

 

 

Gambar 3. 25 Alternatif desain kasar untuk hari raya idul fitri 

 

Untuk desain yang dipilih adalah desain yang terakhir, dengan 

konsep yang digabungkan. Penulis menerima revisi untuk 

melanjutkan desain tersebut dan objek masjid direvisi untuk 

dikembangkan menjadi lebih berbentuk dan tidak datar. Dan penulis 

mengubahnya menjadi bagian kanan kiri dengan warna yang 

berbeda. Tetapi masih dalam tahap revisi dan harus diperbaiki. 

 

Gambar 3. 26 Desain revisi pertama hari raya idul fitri 
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Kemudian, penulis mengubahnya dengan menambahkan warna 

gelap seperti bayangan pada tiap bentuk bangunan atau tiangnya dan 

diberikan bentuk memanjang dengan warna terang untuk 

memberikan kesan highlight pada masjid. Dan desain ini di approve 

oleh supervisor. 

 

Gambar 3. 27 Desain hasil akhir untuk hari raya idul fitri 

 

Pada desain ini penulis mengalami kendala saat mendesain 

bagian masjid, karena menentukan letak warna-warna gelap dan sisi 

gelap terang pada desain. 

e) Cuti Bersama 

Desain pada konten ini tidak dibuatkan sketsa terlebih dahulu, 

penulis langsung membuat desainnya. Desain terdapat notes sebagai 

latar belakang desain, beberapa stiker digital yang mengingatkan 

sebagai pengingat. Penulis juga memberikan tanggal dan kata ‘libur’ 

dibagian atas, untuk memberitahu bahwa tanggal tersebut 

peminjaman Lab FSD UMN tidak beroperasi atau libur. 
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Gambar 3. 28 Desain untuk peringatan cuti bersama 

 

Lalu desain memasuki tahap revisi, menambahkan tahun pada 

bagian atas tanggal, kemudian kata ‘Libur’ diganti dengan bulan dan 

diatas angka tanggal diberikan hari dengan singkatan saja. 

 

Gambar 3. 29 Desain hasil akhir untuk cuti bersama 
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f) Hari Buruh 

Pada hari buruh merupakan konten kedua penulis dengan 

membuat asset desain yang nantinya dijadikan motion graphic untuk 

dianimasikan, penulis membuat beberapa alternatif desain dengan 

tiga konsep yang berbeda, tetapi sebelum membuat desain kasar, 

seperti biasa penulis membuat daftar ide apa saja yang sekiranya 

sepadan dengan tema hari peringatan. 

Tabel 3. 4 List ide untuk konten hari buruh 

HARI BURUH 

- Topi profesi 

- Perkakas 

- Peralatan pekerjaan (profesi) 

- Karakter dengan topi (profesi) 

 

Untuk desain alternatif pertama penulis membuat latar belakang 

yang seolah-olah adalah kain kuit yang sudah dipotong dan sudah 

dijahit ibarat sepatu kulit atau sepatu boots, yang identik dengan para 

pekerja. Kemudian terdapat juga dua karakter yang menggunakan 

topi dengan profesi yang berbeda, lalu ada beberapa objek perkakas 

dan gear. 

 

Gambar 3. 30 Alternatif desain kasar untuk hari buruh 
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Desain alternatif kedua dibuat seperti banner persegi dengan 

beberapa karakter dengan topi profesi yang berbeda. Alternatif desain 

terakhir terdapat beberapa kepala karakter dengan berbagai macam 

topi profesi, objek perkakas dan notes dengan clip pada background. 

Untuk konten ini posisi headline di tengah. Untuk karakter profesi 

penulis memilih enam profesi yaitu polisi, chef, damkar, suster, 

pekerja bangunan dan dokter. Lalu, asset desain perkakas seperti 

gear, obeng, palu, gergaji dan alat medis stetoskop sebagai asset 

pendukung konten. Kemudian untuk desain yang di approve adalah 

desain yang terakhir, dan penulis melanjutkan desain tersebut seperti 

menambahkan mata pada karakter, mengubah tata letak dan 

menambahkan asset desain pada sekeliling desain. 

 

Gambar 3. 31 Desain hasil akhir untuk hari buruh 

 

Kendala pada saat membuat desain ini adalah saat membuat 

karakter dan menentukan topi profesi, karena referensi tidak selalu 

terlihat datar yang sepadan untuk dijadikan vector. 
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g) Hari Waisak 

Penulis membuat daftar ide terkait objek apa saja yang sepadan 

dengan hari waisak, atau objek apa saja yang biasanya identik dengan 

hari waisak. 

Tabel 3. 5 List ide untuk hari waisak 

HARI WAISAK 

- Teratai  

- Lentera 

- Candi 

- Patung Sang Buddha 

- Awan 

 

Penulis juga membuat alternatif desain untuk konten ini, untuk 

desain pertama latar belakang dibuat pola bunga dan terdapat lampu 

lentera, bunga teratai serta awan yang dibuat lebih modern. Lalu pada 

desain kedua dibuat lilin yang menyala diatas bunga teratai dengan 

latar belakang kerlap kerlip bintang dan sedikit desain awan dengan 

style desain yang berbeda lagi. Untuk desain terakhir penulis 

membuat patung Sang Buddha ditengah dan terdapat bunga teratai 

dengan headline hari peringatan dibawah. 

 

Gambar 3. 32 Alternatif desain untuk hari waisak 
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Untuk desain yang dipilih adalah desain ketiga dengan patung 

Sang Buddha. Pemberian warna pada desain tidak terlalu banyak 

karena dirasa sudah cukup dengan desain minimalis, dan proses revisi 

tidak terlalu rumit hanya saja ditambahkan bayangan pada desain 

patung Sang Buddha agar telihat berdimensi dan tidak datar, 

kemudian latar belakang diberikan beberapa objek seperti bintang 

dan awan. Kendala pada desain ini adalah menentukan bayangan atau 

sisi gelap pada desain patung Sang Buddha, dan tata letak beberapa 

objek. 

 

Gambar 3. 33 Desain hasil akhir untuk hari waisak 

 

h) Hari Pancasila 

Pada desain hari pancasila penulis membuat tiga alternatif desain 

dengan sketsa yang sudah ada dan penulis hanya melanjutkannya 

saja. Ketiga desain ini hanya memiliki perbedaan pada latar belakang 

warna saja, desain dibuat dengan konsep latar belakang perangko, 

dengan objek burung garuda ditengah, terdapat objek kapas dan padi 

serta bintang yang diambil dari makna pancasila, kemudian latar 

belakang pada perangko juga diberi desain pulau-pulau yang ada di 
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Indonesia dengan warna yang tidak terlalu kontras karena diberikan 

opacity. 

 

Gambar 3. 34 Alternatif desain untuk hari pancasila 

 

Untuk desain yang disetujui oleh supervisor adalah desain yang 

pertama dengan latar belakang jingga. Lalu untuk desain final 

mendapatkan revisi yaitu memperbesar sedikit seluruh ukuran objek 

desain seperti bingkai perangko, kapas dan padi, bintang, serta objek 

desain yang berada pada dalam bingkai, kemudian untuk pulau-pulau 

tidak perlu opacity. 

 

Gambar 3. 35 Desain hasil akhir untuk hari pancasila 
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i) Hari Raya Idul Adha 

Desain pada konten hari raya idul adha, penulis hanya 

melanjutkan mengembangkan desain dari sketsa atau desain yang 

sudah dibuat oleh rekan kerja. Desain awal adalah desain dengan full 

color, hewan yang terlalu berdempetan, latar belakang polos dan 

tanaman dengan tata letak ditengah, lalu penulis ubah mulai dari tata 

letak hingga menambahkan objek masjid yang diambil dari konten 

hari raya idul fitri. 

 

Gambar 3. 36 Desain untuk hari raya idul adha 

 

Kemudian, untuk letak tanaman penulis letakan pada kanan kiri, 

pada bentuk badan hewan ada sedikit perubahan, pada latar belakang 

desain penulis berikan objek kecil bintang. Setelah beberapa 

pertimbangan dari supervisor, desain mendapatkan sedikit revisi. 
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Gambar 3. 37 Desain akhir untuk hari raya idul adha 

 

Untuk revisi, penulis menambahkan beberapa objek desain 

seperti menambahkan awan pada latar belakang dan menambahkan 

satu tiang masjid agar desain terlihat seimbang. 

Pada proyek ini penulis mendapat beberapa kendala yaitu 

mencari ide untuk asset desain yang sesuai dengan hari raya, 

menentukan objek yang akan dimasukan pada desain, layout pada 

desain, dan penempatan warna. 

Solusi penulis adalah menyusun ide objek atau yang 

berkaitan dengan tema hari raya, dan kemudian dipilih yang sekiranya 

selaras dengan tema dan desain. Lalu, membuat layout kasar atau 

gambaran kasar untuk mengetahui tata letak dan warna. Selain itu, 

karakter laki-laki dan perempuan dibuat sedang bersembahyang. 
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3.3.1.3 Video Tutorial Reels 

Konten video instagram reels dibuat untuk menaikan 

engagement di akun instagram Laboratorium FSD UMN, agar 

mahasiswa Fakultas Seni dan Desain atau mahasiswa UMN lebih 

mengenal dan mengetahui tentang Laboratorium FSD. Kemudian, 

konten video yang dikerjakan penulis berupa tutorial atau tips-tips 

mengenai aplikasi Adobe Illustrator. 

Pada proyek ini penulis mendapatkan kesempatan untuk 

membuat dua konten tutorial. Berikut konten video tutorial Adobe 

Illustrator yang penulis buat: 

a) 5 Secret Adobe Illustrator Hack 

Pada video konten pertama, penulis mencari ide dan  

membuat list ide mengenai tips-tips Adobe Illustrator yang 

nantinya akan dijadikan konten. Berikut list ide konten untuk 

video tutorial yang terdiri dari enam tips menggunakan Adobe 

Illustrator. 

Ide dipilih karena mudah dilakukan dan sudah sesuai dengan 

hasil riset. Sebelum ide dibuatkan video, penulis mencoba untuk 

mempraktikan ide tersebut di Adobe Illustrator. Jika hal tersebut 

susah untuk dilakukan penulis tidak akan mencantumkan ide 

tersebut dalam video. 

Untuk sumber ide, penulis mencari di halaman sosial media 

seperti youtube, instagram, tiktok dan pinterest. Dan biasanya 

konten yang ditampilkan berupa video dengan durasi panjang. 

Penulis juga berharap video ini menjadi panduan, dan 

pengetahuan bagi yang ingin belajar mengenai menggunakan 

fitur-fitur yang terdapat pada aplikasi Adobe Illustrator. 
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Tabel 3. 6 List ide untuk konten video tutorial (1) 

5 Secret Adobe Illustrator Hack 

Tutor Keterangan 

1. Trim View 

-View > Trim View 

Hanya melihat objek yang ada di dalam 

artboard saja. 

2. Customize Layout 

-Window > New Window 

-Window > Arrange > Tile 

Split 2 windows. 

4. Waves Line 

-Buat line > Effect > Distort & Transform > 

Zig zag 

-Copy paste line 

Membuat line bergelombang tanpa 

menggunakan pen tool. 

5. Selecting The Same Color 

-Select > Same > Fill color 

Memilih object sesuai dengan warna 

yang dipilih (tidak select manual).  

6. Blend Menggunakan 2 warna yang berbeda. 

 

b) Secret Adobe Illustrator Hack #Part 2 

Berikut list ide konten untuk video tutorial kedua yang terdiri 

dari tiga tips menggunakan Adobe Illustrator. Untuk konten 

kedua penulis mencari ide fitur dari Adobe Illustrator yang cukup 

rumit, terjadi beberapa kendala juga seperti tidak semua hasil riset 

penulis dapat dicoba karena perbedaan versi aplikasi yang penulis 

gunakan dengan aplikasi yang ditampilkan saat riset ide. 

Setelah semua ide sudah terkumpul, penulis melanjutkan pada 

proses rekam layar untuk nantinya di edit dan kemudian jadi 

sebuah konten video tutorial. Untuk kendala pada konten video 

kedua ini adalah mencari ide video dan mengatur ukuran layar. 
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Tabel 3. 7 List ide untuk konten video tutorial (2) 

 

Setelah menentukan tips apa saja yang akan masuk pada 

konten, penulis membuat settingan ukuran Adobe Illustrator menjadi 

potrait agar nantinya sesuai dengan ukuran handphone atau instagram 

reels. Penulis menggunakan aplikasi pendukung untuk merekam layar 

yaitu, game capture. 

 

Gambar 3. 38 Ukuran window adobe illustrator untuk konten 

 

Secret Adobe Illustrator Hack #Part 2 

Tutor Keterangan 

1. Scale Stroke Garis pada objek ikut berubah saat di resize. 

2. Delete Anchor Menggunakan tool delete anchor point tool yang 

benar. 

3. Transform Effect 

 

Membuat shape berulang kali dari terbesar sampai 

terkecil. 
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Selanjutnya penulis mengedit video hasil rekam layar 

menggunakan aplikasi Capcut, karena dianggap lebih mudah untuk 

mengedit secara memotong video, menambahkan teks dan 

menambahkan transisi pada video. Untuk proses mengedit penulis 

memotong semua video yang penting untuk mengetahui berapa lama 

durasi pada konten tersebut. 

 

 

Gambar 3. 39 Tampilan mengedit video menggunakan aplikasi Capcut 

 

Penulis juga harus mendesain halaman awal untuk tampilan 

depan pada instagram reels, halaman awal didesain menggunakan 

aplikasi Adobe Illustrator. Halaman hanya menampilkan headline dan 

isi konten saja. 
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Gambar 3. 40 Cover Konten instagram reels 

 

Kemudian, penulis menemukan beberapa kesulitan pada 

proyek ini, yaitu mencari ide untuk konten video yang singkat dengan 

beberapa tips didalamnya, lalu kesulitan selanjutnya mengedit video 

pada aplikasi Capcut dengan menggunakan beberapa fitur yang ada di 

aplikasi tersebut karena belum terbiasa. 

Solusi yang penulis lakukan adalah mencari tahu di situs 

internet dan bertanya pada rekan kerja atau mencoba untuk 

mempraktikkan sendiri. 
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3.3.1.4 Asset Visual Materi non Akademis 

Pada proyek ini penulis diminta untuk membuat asset visual 

untuk materi non akademis mengenai intro to basic menggunakan 

aplikasi Adobe Illustrator untuk membuat komposisi menggunakan 

objek sehari-hari. Asset visual dibuat sederhana agar mudah dipahami 

saat dipraktikkan. Penulis juga menyisipkan shortcut dan beberapa 

tips membuat asset visual disetiap bentuknya untuk informasi yang 

lebih rinci. 

Asset visual pertama penulis membuat kamar tidur dengan 

delapan objek yaitu lampu belajar, alat tulis kantor, buku, poster, 

tempat dokumen, kertas catatan, kalender, dan meja belajar. Bentuk 

pertama yang dibuat adalah meja belajar, dibuat seluruhnya 

menggunakan rectangle tool.  

 

 

Gambar 3. 41 Membuat asset meja belajar 
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Selanjutnya penulis memberikan beberapa mengenai tips 

shortcut dan fitur pada Adobe Illustrator yang digunakan untuk proses 

yang berlaku untuk membuat objek lainnya. Penulis memberikan 

rincian mengenai cara menyalin objek dengan cepat dan bentuk yang 

sejajar serta dengan shortcut nya, penulis juga memberikan cara 

penggunaan fitur pathfinder yaitu fitur menggabungkan objek atau 

merge. 

 

 

Gambar 3. 42 Penjelasan shortcut fitur pada adobe illustrator 
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Asset visual kedua membuat kamar tidur dengan sembilan 

objek, yaitu tempat tidur, lampu, lemari kecil, tanaman, piala, poster, 

rak tempel, buku dan karpet. Pada asset ini hampir seluruhnya penulis 

menggunakan fitur pathfinder untuk membuat objek. Untuk 

pemilihan warna menggunakan warna yang cenderung pada warm 

dark color agar dapat dibedakan warna tiap objeknya dan tidak 

menggunakan banyak warna agar tidak membingungkan. 

 

 

Gambar 3. 43 Asset desain membuat kamar tidur 

 

Asset visual selanjutnya adalah laptop dan mouse, untuk 

asset ini tidak seluruh objek menggunakan pathfinder tetapi 

menggunakan pen tool. Pada desain ini hanya membuat dua objek saja 

karena dirasa cukup rumit pada membuat bentuk laptop, untuk 

referensi mouse penulis memotret dari mouse milik penulis. 

 

 

Gambar 3. 44 Asset desain laptop dan mouse 
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Kesulitan membuat asset visual ini adalah mencari objek dan 

mengatur objek agar sesuai komposisinya disetiap asset visual yang 

sudah dibuat. 

Penulis juga menemukan solusi atas kendala yang dialami, 

yaitu mencari contoh desain dengan komposisi yang baik dan tidak 

terlalu padat sehingga memudahkan penulis untuk menempatkan 

objek pada desain yang sudah dibuat. 

 

3.3.1.5 Asset Visual Website 

Pada proyek ini penulis diminta untuk membuat asset desain 

untuk website Gapura UMN, penulis bekerjasama dengan associate 

lab dalam perancangan website ini. Gapura UMN merupakan layanan 

kampus yang dirancang untuk memenuhi berbagai macam kebutuhan 

mahasiswa UMN. Gapura ingin memperbarui websitenya, kemudian 

penulis ditugaskan oleh PIC untuk mendesain asset dan mendesain 

logo pada proyek ini. Seluruh asset desain dibuat menggunakan 

aplikasi Adobe Illustrator. 

 

 

Gambar 3. 45 Website Gapura UMN 
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Hal yang dilakukan oleh penulis dan tim adalah membedah 

website gapura untuk mengetahui apa saja yang harus diperbarui 

terkait UI/UX-nya, lalu riset website lain untuk mencari ide referensi 

perancangan. Setelah beberapa pertimbangan website akan diperbarui 

dengan konsep yang modern dan lebih praktis saat digunakan, penulis 

diminta untuk membuat supergrafis sebagai visual pendukung 

thumbnail pada website. 

 

 

Gambar 3. 46 Referensi supergrafis 
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Penulis ditugaskan untuk membuat desain berupa blob 

shape. Selanjutnya mencari ide bentuk blob dengan berbagai macam 

variasi yaitu blob dengan warna solid, gradient, dan beberapa macam 

variasi gradient. Yang sekiranya cocok untuk website, setelah 

menemukan referensi yang tepat penulis membuat beberapa alternatif 

desain bentuk blob yang terdiri dari 5 alternatif. 

 

Gambar 3. 47 Palet warna Gapura 

 

Kemudian untuk warna yang digunakan adalah warna dasar 

yang ada pada logo Gapura dan kemudian dikembangkan oleh 

penulis, karena penulis tidak ingin menghilangkan kesan warna yang 

lama. Untuk asset desain yang digunakan adalah asset dengan warna 

gradient yaitu nomor satu yang terdapat pada gambar. 

Asset desain pertama dengan bentuk yang sama, warna yang 

sama, tetapi jumlah layer yang berbeda. Untuk bagian atas dengan 

layer yang banyak sehingga objek desain terlihat padat, kemudian 

untuk bagian bawah dengan layer sedikit sehingga desain tidak terlihat 

garis yang padat. 
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Gambar 3. 48 Supergrafis website Gapura UMN (1) 

Untuk alternatif desain ketiga sampai lima, menggunakan 

bentuk dengan warna yang solid tetapi masih dengan menggunakan 

gradient. Perbedaannya hanya saja menggunakan objek tambahan dan 

diubah opacitynya. 

 

 

Gambar 3. 49 Supergrafis website Gapura UMN (2) 

 

Setelah membuat supergrafis, penulis melakukan proses 

membuat logo Gapura. Tahap pertama yang dilakukan mencari 

referensi logo dan mencari font yang digunakan pada logo Gapura.  
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Lalu penulis membedah logo Gapura, font yang digunakan 

pada logo Gapura adalah Avenir LT Std 95 Black, objek visual yang 

berada pada kiri atas logo hanya hiasan, dibawah logo Gapura terdapat 

tagline yaitu ‘UMN One Stop Service’. 

Rencana pada brief awal, logo hanya akan diubah huruf ‘G’-

nya saja, karena dikira kurang serasi dengan huruf lainnya maka akan 

di re-design satu logotype nya. Berikut alternatif logo dari huruf ‘G’ 

yang sudah dibuat: 

 

 

Gambar 3. 50 Alternatif logo huruf ‘G’ 
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Penulis juga telah membuat beberapa alternatif logotype 

yang masih banyak pertimbangan, logo pertama didesain 

menggunakan beberapa elemen bentuk karena mencerminkan arti dari 

Gapura UMN yaitu pintu gerbang layanan terpadu. Maka penulis 

membuat huruf ‘G’ seperti pagar  dan setengah lingkaran yang terbagi 

dua sebagai pintu masuk dari pagar tersebut. Tetapi masih kurang 

sepadan dengan website Gapura, maka dilakukan revisi ulang dan 

membuat beberapa alternatif untuk logotype. 

 

 

Gambar 3. 51 Alternatif logotype Gapura 

 

Logotype didesain pada tiap hurufnya dengan menggunakan 

bentuk organik sehingga terlihat tidak kaku. Untuk pemilihan warna 

berdasarkan hasil warna yang sudah dikembangkan dari palet warna 

yang sudah ada pada logo Gapura. Warna yang digunakan merupakan 

warna biru UMN, hijau tosca, jingga, dan kuning. 
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Berikut penjelasan arti warna yang digunakan pada logo 

Gapura berdasarkan pada buku Marioka, A. & Stone, T. (2006) yang 

berjudul ‘Color Design Workbook: A Real-World Guide to Using 

Color in Graphic Design’.  

 

Tabel 3. 8 Penjelasan arti warna pada logo Gapura 

No. Warna Arti 

1. Biru Justice, setiap individu yang berstatus sebagai civitas akademika 

UMN berhak untuk mendapatkan kesempatan untuk menggunakan 

fasilitas di UMN. 

2. Hijau Tosca Harmony, memiliki arti berbagai divisi di UMN memberikan 

layanan reservasi, dan Gapura sebagai salah satu gerbang bagi 

mahasiswa UMN untuk reservasi ruangan. Karena semua keperluan 

fasilitas menjadi satu di Gapura UMN. 

3. Jingga Intellect, memiliki arti cerdas, penalaran atau pemahaman, 

pengetahuan secara obyektif yang berkaitan dengan hal-hal abstrak 

atau akademis. Dikaitkan dengan Gapura karena memiliki banyak 

informasi-informasi yang ada pada website sehingga mahasiswa, 

dosen maupun staff UMN dapat mengetahui banyak informasi 

terkait pengajuan berkas, peminjaman fasilitas serta hal lain yang 

berkaitan dengan belajar mengajar. Fasilitas UMN juga memiliki 

fungsi sebagai tempat menimba atau mengasah ilmu, seingga setiap 

fasilitas di UMN memiliki fungsi edukasi yang beragam. 

4. Kuning Activity, mengingat bahwa banyak hal yang dapat diajukan pada 

website Gapura terkait berkas-berkas dan peminjaman fasilitas 

kampus. Kegiatan yang dilakukan baik itu mencakup peminjaman, 

permasalahan seperti absensi, dan sebagainya. Sehingga Gapura 

menjadi satu gerbang kegiatan administrasi di UMN. 
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Pada tahap ini huruf ‘r’ terlihat kurang sepadan karena 

terlihat kurang nyaman untuk dilihat, sehingga penulis membuat 

pilihan alternatif desain untuk bentuk huruf ‘r’. 

 

Gambar 3. 52 Alternatif desain logo huruf ‘r’ 

 

Penulis dan tim sempat mencoba untuk mengubah warna 

logo menggunakan palet warna dasar yang terdapat pada logo Gapura. 

Lalu, penulis membuat perbandingan logo degan warna kuning, 

jingga, hijau tosca, dan biru, dengan warna logo kuning, hijau daun, 

merah dan biru. Akan tetapi tim kembali dengan pilihan awal. 

 

Gambar 3. 53 Logotype menggunakan palet warna lain. 
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Selanjutnya, tim masih merasa logotype masih kurang 

sepadan dan kaku, maka penulis disarankan untuk mengubah bentuk 

logotype pada tiap bentuk sudut huruf yang lancip menjadi bentuk 

round. Karena terlihat lebih organic dan nyaman untuk dilihat, serta 

mencerminkan kesan yang modern. 

 

 

Gambar 3. 54 Hasil revisi logotype menjadi round 

 

Proses kerja selanjutnya adalah mempertimbangkan logo 

warna baru dengan background website Gapura yang telah diperbarui. 

Namun setelah melakukan perbandingan logo dengan website, logo 

tidak terlihat dan terlalu kontras. 

 

 

Gambar 3. 55 Alternatif logo Gapura final 
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Karena warna logo terlalu kontras atau terang dan kurang 

senada dengan website, penulis membuat pilihan lain yaitu dengan 

membuat logo alternatif lainnya menggunakan satu warna dan logo 

dengan palet warna baru yang dibuat menjadi gradient, namun garis 

potongan bentuk pada setiap hurufnya masih ada. 

 

 

Gambar 3. 56 Alternatif logo Gapura yang digunakan 

 

Kemudian, penulis membuat logo alternatif kedua yaitu 

warna dengan gradient di setiap lekukan hurufnya. Namun logo yang 

disetujui oleh PIC adalah logo pilihan kedua, yaitu dengan gradient. 

Pada proyek ini penulis mendapatkan beberapa kesulitan 

yaitu mencari ide saat membuat logo secara bentuk dan pemilihan 

warna yang akan digunakan, kesulitan selanjutnya adalah proses 

pembuatan logo dengan waktu yang singkat. Lalu menentukan bentuk 

yang akan digunakan atau digabungkan serta menentukan desain-

desain dengan bentuk organik. 

Adapula kesulitan lain seperti membuat konsep pada logo, 

dan mencari arti warna yang sesuai dengan konsep logo. Karena 

semua yang sudah dibuat harus sesuai dengan UMN. 
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Solusi yang dilakukan oleh penulis adalah mengumpulkan 

beberapa ide perancangan logo, kemudian mencari tahu warna yang 

tepat seperti apa yang baik untuk perancangan logo. Untuk penjelasan 

arti warna dan lainnya, penulis mencari beberapa buku yang berkaitan 

dengan arti warna saat mendesain logo, kemudian penulis juga 

mencari tahu warna yang penulis gunakan untuk logo Gapura masuk 

pada kategori apa, sehingga perancangan logo sesuai dengan apa yang 

sudah dibrief sejak awal. 

 

3.3.2 Kendala yang Ditemukan 

Selama periode magang berlangsung, penulis mendapatkan beberapa 

kendala yang dihadapi, berikut kendalanya: 

1. Perbedaan pendapat dan kesalahpahaman penulis dengan 

pembimbing lapangan terkait desain yang sudah dibuat. 

2. Merasa kesulitan saat mengedit video, karena tidak paham terkait 

membuat konten. 

3. Sempat merasa kesulitan saat mencari ide untuk desain konten 

instagram post hari raya. 

4. Waktu periode magang ditempat magang dengan timeline magang 

dari prodi berbeda. 

3.3.3 Solusi atas Kendala yang Ditemukan 

Setelah mengalami beberapa kendala saat periode magang, penulis 

juga menemukan solusi atas semua kendala yang dialami dan telah dilakukan, 

berikut solusinya: 

1. Penulis mencari tahu dan memahami masukan yang diberikan oleh 

pembimbing. 

2. Bertanya pada pembimbing atau rekan kerja terkait aplikasi dan 

meminta bimbingan dan masukan mengenai video konten. 
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3. Membuat list ide per-objek terkait tema konten hari raya, agar dapat 

disimpulkan dan digabung menjadi satu ide yang sesuai dengan 

tema.  

4. Mempercepat 640 jam kerja dengan mengambil lembur, sehingga 

timeline selesai magang pada bulan Mei 2024, karena harus tercatat 

dalam sistem pada website Kampus Merdeka UMN. Tetapi kontrak 

dengan tempat magang tetap berjalan karena sesuai dengan 

kesepakatan awal yaitu 12 Februari 2024 sampai dengan 19 Juni 

2024.  


